
LABELMARK 5.13 Release Notes 
Build 5.13.0.7 (April 2014) 

New Features/Enhancements 

Pro Edition 

• Text import enhancements for XMT, when enabled 

LABELMARK 5.12 Release Notes 
Build 5.12.09 (December 2013) 

New Features/Enhancements 

Standard Edition 

• New label parts for the following printers: IP 300 and 600, BP-PR 300, 360, 600 and 
BBP72 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

• While an unlicensed demo installation always runs as LabelMark Pro edition, a 

licensed LabelMark Pro install can be forced to run as Standard by passing the text 

"/Standard" as a command line argument without quotes 

Bug Fixes 

• Data imports to double sided sleeves populate fields on both sides 

• Correctly report missing label files from job files with a "File not found <filepath>" 

message 

• When importing data to multi-column labels (ex. DAT-79), starting on second or 

subsequent column, the "Down then Over" option places data in the correct columns 

• Text mode labels with linked text flip-flop correctly top-to-bottom for both odd and 

even label counts 

• For label parts M-124-461, M-125-461 and M-126-461, text can be entered at the 

top left corner 

• Correct printer-part adjustments and user changes are shown in the Tools-> Manage 

Printer/Part Pairing display 

• Graphic lines in Identilab files appear correctly in LM5.12 

• When opening legacy Labelmark files (*.lm3, *.lm4) rotation of linked objects is 

preserved 

• LabelMark 5 employs TrueType fonts for label design, display and print. OpenType 

fonts are not supported 

LABELMARK 5.11.0 Release Notes 
Build 5.11.0 (August 2013) 

New Features/Enhancements 



Standard Edition 

• Support for BMP-41 printer 

• More data placement options are available during import and serialization operations 
• Support for B-344 Fluid Resistant sleeves 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

Bug Fixes 

• By virtue of a Microsoft design decision, the Arial Narrow font has bold and italic 

styles by default; these styles cannot be removed. 

• Printer Parts Pairing are used in printing to adjust label content for part paired with 

printer 

• When printing, part named in label file is compared with part loaded in printer. Upon 

mismatch, user is offered option of canceling the print operation 

• Add part PTL-47 for legacy support, use correct dimensions for part BPTL-109 

• The CSA logo does not appear on graphic images installed by LabelMark 
• LabelMark 5.11 correctly auto-updates previous versions 

LABELMARK 5.10.0 Release Notes 
Build 5.10.0 (March 2013) 

New Features/Enhancements 

Standard Edition 

• No new features. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

Bug Fixes 

• Exception on opening recently used job if it's currently opened 

• Fixed text entry issues in Line Mode labels 

• Fixed part defintion for M-103-427 
• Autofit doesn't work for rotated field in free mode 

LABELMARK 5.9.0 Release Notes 
Build 5.9.0 (Feburary 2013) 

New Features/Enhancements 

Standard Edition 

• Added support for BP-PR300+CS printer. 



• Added parts for BP-PR300+CS. These parts begin with PS-C, HX-C, HT-C and ZH-Z 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

Bug Fixes 

• Improved opening and printing of LabelMark 3 and 4 files. 

• Fixed help file topics. 

• Fixed THT-149, THT-17 part definitions. 

• Improved printing on HCPS-0.9-3336. 
• Fixed minor editor and data import issues. 

LABELMARK 5.8.1 Release Notes 
Build 5.8.1 (October 2012) 

New Features/Enhancements 

Standard Edition 

• Added UID label templates. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

Bug Fixes 

• Improved quality of images imported from AutoCAD™ 

• Improved quality of transparent images. 

• Data is persisted for text obejcts if in a locked template field. 

LABELMARK 5.7.1 Release Notes 
Build 5.7.1.X (Aug 2012) 

New Features/Enhancements 

Standard Edition 

• BBP33 Hassle-free printing: LabelMark communicates with the BBP33 printer to 

detect the tape and ribbon supplies currently installed in the printer so you can easily 

create labels for the supply in the printer. LabelMark can also warn you at print time 

if you do not have the correct supply in the printer for the file you are about to print. 

• BBP33 Parts: The parts database was updated to include new BBP33 parts. Most of 

the new parts start with ‘B33-‘, ‘B33C-‘, ‘B30-‘, or ‘B30C-‘. 

• Windows 8 Compatible: LabelMark and the LabelMark Add-Ins are Windows 8 

compatible. 



• Insert Data Serialization: Users can now choose which type of barcode will be used 

with a serialization. This means all valid characters for a specific barcode type can be 

used in the serialization instead of just the valid characters for the Code39 barcode. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

• Row copies for slit sleeve parts: Users now have the ability to choose between 

specifying label copies or row copies for slit sleeve parts. 

• Updated Datacomm Product List: The product list in the Datacomm wizard has been 

updated with new Brady parts and new dimensions. 

Bug Fixes 

• Change Label Part: Improved the logic that determines if the zones are compatible 

between the old and new part. 

• Datamatrix barcodes: Fixed a problem when changing between encoding types in 

Datamatrix barcodes that caused the data to be incorrect. The problem only occurred 

in specific scenarios where the data contained uppercase letters and punctuation 

symbols followed by another type of data such as numeric data. 

• Importing Excel Data: Added a check for empty columns when importing Excel data 

that was causing an error and preventing the user from performing a simple data 

import. 

• LabelMark Parts: Fixed the part definitions for the following parts: THT-147-422, 
THTEP-180, and THTEP-181 

LABELMARK 5.6 Release Notes 
Build 5.6.0.121 (May 2012) 

New Features/Enhancements 

Standard Edition 

• Manage favorite part list: Custom parts can now be added to the Favorite part list. 

• Advanced data import: Users can now import fields from one datasource to any label 

in a row of labels in one data import. If you are importing data to a part that has 

more than one label per row, you can specify which import fields map to which label. 

• Duplicate data at print time: Users have the option to duplicate their data from side 

1 to side 2 at print time so that the exact same data is always printed on both sides. 

• Application defaults: Added the following new default settings: default view of 

double-sided materials, default orientation of second side when printing, and default 

duplicate data on second side at print time. 

• Print label set in reverse: In the print dialog, users can specify to print their label set 
in reverse. Instead of printing labels 1,2,3 LabelMark will print the labels 3,2,1. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

• Row copies for slit sleeve parts: When designing a label file created from a slit sleeve 

part, the label copies edit box in the designer will only show for the first label in each 

row. Instead of tracking the copies for each label, it will be used to specify the 



number of copies for that row of labels. This change will allow users the ability to 

specify how many times they want to print a specific sleeve without having to create 

a print range for each sleeve. 

Bug Fixes 

• Data Import Excel Workbook: Fixed a problem that prevented users from importing 

data from an Excel workbook that contained worksheets with data filters. 

• Flip Flop: Fixed a bug that removed leading and trailing spaces when reading in the 

flip flop character setting. 

• Data Import: Relaxed the restriction on the file extension for data import source files 
so that files with a .tab extension will be allowed. 

LABELMARK 5.5.5 Release Notes 
Build 5.5.5.49 (Mar 2012) 

New Features/Enhancements 

Standard Edition 

• Seralization & Template Objects: Added the ability to apply a serialization into a 

template text object when creating a file from a template. 

• Printer Management Utility Excel Add-In: When opening a printer file, the add-in will 

show the dimensions of the supply the file was created with and compare it to the 
supply currently installed in the printer. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

• Updated Datacomm Product List: Added 2 new product definition for Belden patch 

panels. 

Bug Fixes 

• Printing an opened wiremarked label: Added a check when opening files with 

wiremarked labels to make sure that the text is repeated in case you print right 

away. 

• Incomplete template on labels: Fixed a problem that occurred when doing a data 

import refresh on a file that was created from a template. If the data source 

increased in size causing more labels to be created in the label file, the new labels 

would not have all the template objects on them unless the data import was linked to 

all of the available template objects. 

• Extra template label: Templates that were created from a part that has a pre-printed 

image on it were causing a second label to be added to the template. Now the 

template set only contains one label with the pre-printed graphic and your template 

objects unless you specify that you want a second label. 

• Opening LabelMark 4 files: Fixed a problem that occurred when opening LabelMark 4 

files where a part with the same name was defined differently in LabelMark 4 when 

compared to the part definition in LabelMark 5. 



• Opening LabelMark 4 files: When opening LabelMark 4 files that were created with a 

zoned continuous part, the zone height was not being set correctly in the LabelMark 

5 part definition. 

• Opening LabelMark 4 files: If an LabelMark 4 file contains an object property that is 

not in the valid range for LabelMark 5, LabeLabelMarkark will not longer throw an 

unhandled exception. The property will show in an error state so that it can be fixed. 

• Opening LabelMark 4 files: We are now taking into account the linespacing when 

simulating wiremark mode in a graphical label so that the number of text objects in 

LabeLabelMarkark 4 and LabeLabelMarkark 5 are equal. 

• THT-92, THT-93, THT-94: Changed the part definition for these parts so that a 

serialization will print out 1,2,3, etc.. Instead of 3,2,1, etc… 

• THT-77: Added this part to the LabelMark parts database. It was in the LabelMark 4 

database but was missed when we moved to LabelMark 5. 

• Label Saver: Fixed the calculation of how many labels to skip over when starting the 

print job with the label saver option specified and a part that has an output 

orientation value of landscape. 

• BMP51(53) parts in wizards: Added the appropriate BMP51(53) parts to each of the 

wizards in LabelMark. 

• Opening LabelMark 5 file: If a LabelMark 5 file was created before LabelMark 5.4 and 

it contained a data import with a different number of sort and filter criteria, the file 

could not be opened in LabelMark 5.4 and after. 

• DotMatrix Lexmark printing: Fixed a problem where the page size was getting set 

incorrectly for Lexmark printers when printing to a DotMatrix part. 

• Copy label to new label: If a label file was created from a template, when a user 

tried to copy an existing label to a new label, any text that was in the template text 

object was not being copied to the new label. 

• BMP51(53) parts: Changed the orientation of some lab parts from portrait to 

orientation 

• Default repeat length: Fixed the minimum default repeat length in the Data 
Extraction Add-In. The minimum is 0.125" which matches LabelMark. 

Known Issues 

• Import Excel data in LabelMark: If the Microsoft JET or ACE engine assigns the 

incorrect type to a column of Excel data, the whole column of data may be missing 

or the data may be missing on only certain labels. See the knowledge base articly 

here for more information: 
http://www.qualityserviceandsupport.com/brady/article/5961 

LABELMARK 5.5.3 Release Notes 
Build 5.5.3.2 (Dec 2011) 

New Features/Enhancements 

Standard Edition 

• Changed Permasleeve Part Heights: The permasleeve part heights were changed 

back to the larger value used in LabelMark 4.x. 

• Application defaults: Added an option in the application options so the user can 

choose which part list is selected by default whenever LabelMark shows the part list. 

The options are Master, Favorites, and Custom. 



• Wizard navigation: If multiple label files are being created by a wizard, the wizard 

will navigate to the next label file in an error state within a step when the user clicks 

Next. In previous versions, the user would have to click on the label file in an error 

state and fix the error before the Next button would be available. 

• Part list filtering: LabelMark will remember any part list filters entered by a user 
when changing between different part lists 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

Bug Fixes 

• Part Database Updates: Updated the part definitions for THT-33 and 3PS-125-2-WT-

4 

• Adding label file to job: When a label file is added to a job and the label file was 

created from a part that has been paired with a specific printer, the printer is chosen 

by default. 

• Label error checking: When the user clicks print, sometimes the error checking 

window would check more labels than necessary. This was also causing some 
confusion over how many labels were going to be printed. 

LABELMARK 5.5.2 Release Notes 
Build 5.5.2.3 (Nov 2011) 

New Features/Enhancements 

Standard Edition 

• BMP51(53) Hassle-free printing: LabelMark communicates with the BMP51(53) 

printer to detect the cartridge supply currently installed in the printer so you can 

easily create labels for the supply in the printer. LabelMark can also warn you at 

print time if you do not have the correct supply in the printer for the file you are 

about to print. 

• BMP51(53) Parts: The parts database was updated to include new BMP51(53) parts. 

Most of the new parts start with ‘M-‘ or ‘MC-‘ 

• LabelMark startup time: Removed a lot of the idle time in the startup sequence for 

LabelMark where the splash screen was showing without any progress being made 

on starting up the application 

• Number precision: Updated some of the new fields added with the DataComm wizard 

to use 3 decimal places to be consistent with other fields in LabelMark. 

• Hassle-Free part selection: If the user is having a problem with a stock part 

definition, they can create a custom part based on that stock part. When LabelMark 

gets the part infomartion from the printer, it will check the custom part definitions 

before the stock part definitions. This allows users to tweak a part defintion and have 

LabelMark choose that custom part definition when the matching part is detected in 
the printer. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 



Bug Fixes 

• LAT-39: Updated the part definition for LAT-39 to show the unprintable area of the 

self-laminating material. 

• PTL-21-427: Updated the part definition for PTL-21-427 to show the unprintable area 

of the self-laminating material. 

• Text objects from templates: Fixed a bug where text objects from templates did not 

hold their fixed size on template files created between LabelMark 5.0 and LabelMark 

5.3 

LABELMARK 5.5 Release Notes 
Build 5.5.0.144 (Aug 2011) 

New Features/Enhancements 

Standard Edition 

• LabelMark Printer Management Utility: This is a new Excel add-in that can be used 

with BMP71 printers to transfer printer files to/from a printer, import Excel data into 

a printer file, and check for firmware updates to your BMP71 printer. This add-in 

does not require a LabelMark license to use. Note: If you have the LabelMark Excel 

add-in installed, you will need to upgrade it to the latest version in order to use this 

new add-in. 

• Edit continuous part length: When creating label files based on a continuous part, 

users are able to change the label length without having to create a new label file via 

the Label Object Properties window. 

• Hassle-Free part selection: If the user is having a problem with a stock part 

definition, they can create a custom part based on that stock part. When LabelMark 

gets the part infomartion from the printer, it will check the custom part definitions 

before the stock part definitions. This allows users to tweak a part defintion and have 

LabelMark choose that custom part definition when the matching part is detected in 
the printer. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

• Updated AutoCAD support: The LabelMark add-in now support AutoCAD 2011 and 
AutoCAD 2012. 

Bug Fixes 

• Wraptor file name: When printing to a Wraptor printer, LabelMark will provide the 

filename to the driver so the user will not be prompted to enter a new file name. This 

bug was only found on 32-bit machines. 

• LAT-39: Updated the part definition for LAT-39 to show the unprintable area of the 

self-laminating material. 

• PTL-21-427: Updated the part definition for PTL-21-427 to show the unprintable area 

of the self-laminating material. 

• Text objects from templates: Fixed a bug where text objects from templates did not 

hold their fixed size on template files created between LabelMark 5.0 and LabelMark 

5.3 



LABELMARK 5.4 Release Notes 
Build 5.4.1.12 (July 2011) 

New Features/Enhancements 

Standard Edition 

• Choose pre-printed supply type: When the user chooses a pre-printed part that has 

multiple pre-printed options, they user will be given the option to choose which pre-

printed material they are using. If the user does not choose one of the options, the 

label file will be created but no pre-printed graphic will be displayed. 

• Printing ranges of labels: Changed the user interface for specifying range copies and 

label copies when printing ranges of labels. 

• Text properties toolbar: Added font size increase/decrease buttons to the text 

properties toolbar. 

• Application defaults: The user can choose to set a static default zoom factor that is 

used when a label file is created or opened in the application defaults. 

• Vertical Alignment in non graphical mode: The vertical alignment functionality works 

like LabelMark 4.x where only non empty lines are used in the the new alignment. 

• Sticky Text Tool: After creating a text object in non graphical mode, the text tool 

does not change back to the pointer tool allowing you to create more text objects 

without having to go back to the toolbar and selecting the text tool again. 

• Edit 110 block layout in editor: After using the 110 block wizard to generate a label 

file, users can modify the block and label widths without having to go back through 

the wizard if the layout of the blocks need to be adjusted. 

• Custom SQL Query: Users who are working with complex data sets and need more 

control over the SQL query used to pull the data out can design a custom SQL query 
that their requirements. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

• DataComm Wizard: Use the DataComm wizard for labels designed to fit certain 

manufacturers' data communication panels. If the desired manufacturer or product is 

not listed, you can define your own data and save it as a custom product. 

Bug Fixes 

• Importing data to rotated objects: After importing data to rotated objects, the top 

left corner of the objects stays consistent from label to label. 

• Split legacy text object: When LabelMark 5.x opens a file from LabelMark 4.x or 

LabelMark 3.x and the file contains a text object with static and variable data, the 

legacy object into 2 text objects. One text object will contain the static data and one 

will contain the variable data. 

• THT-19-430 and THT-17-430: Added these materials to the parts database so they 

have the correct gap sensor setting. 

• Opening legacy files - Some legacy files that were created from legacy templates 

with graphic template objects were not opening. 

• Fixed M71EP-176-593 part definition: The part height was defined incorrectly. 

• Custom continuous part for IP Printer: When creating a label file using a custom 

continuous part for the IP printer, the user was not able to set the label file's repeat 

length. 



• Skipping PS-125-2 labels during print: The part height was defined incorrectly 

causing the printer to leave blank labels during a print job 

• Transfering license: LabelMark would fail to transfer a license if the new machine's 

clock was ahead of the old machine's clock. 

• Autofit wiremark templates: When a user imports data into an autofit wiremark 

template, LabelMark is going to ignore the fixed size of the template in order to allow 

the height of the text box to shrink to fit to the smaller text 

• Font size change: LabelMark will not notify a user if a font size change is going to 

cause an empty line to go off the label 

• BPT part definitions: Fixed BPT-7 and BPT-17 part definitions to print correctly to the 

BBP11 printer 

LABELMARK 5.3.2 Release Notes 
Build 5.3.2.4 (Jan 2011) 

Bug Fixes 

• Fixed object placement on rotated zones for LM 3.x files: On non graphical labels, 

objects were not placed correctly when opening LabelMark 3.x files that contained 

zones rotated 180 degrees. 

• Missing data when inputting data from barcode scanner: When using a barcode 

scanner to enter data on a label, some of the data would not be processed before 

LabelMark got the command to navigate to the next line or label. 

• Error adding text object to last label with template objects: When you create a label 

file based on a template and allow the user to add new objects to the file, an error 

would occur if you tried to add a text object as the first new object. 

• Fixed bug when using autofit text on a non graphical label based on a template: If 

you created a non graphical label from a template file, an error would occur if you 
set one of the text objects to be autofit and you tried to enter text into it. 

LABELMARK 5.3.1 Release Notes 
Build 5.3.1.2 (Nov 2010) 

Bug Fixes 

• Failed to get part info for networked IP printer: LabelMark was not getting the 

bidirectional information from networked IP printers. 

• Error creating most recently used files list: LabelMark was displaying an error during 

startup if there were LabelMark 4 or IdentiLab files in the most recently used files 

list. 

LABELMARK 5.3 Release Notes 
Build 5.3.0.140 (Nov 2010) 

New Features/Enhancements 

Standard Edition 

• BBP72 printer: LabelMark supports printing to the double sided printer using stock 

and custom parts. When you define a custom part for the BBP72 printer you need to 



specify the liner width for the part to ensure the second side is printed in the correct 

location. 

• Duplicate data on second side: When doing advanced data import or serialization, 

users can choose to duplicate the linked data on the second side of a two sided part. 

• Lock template layout: Users who design template files can lock the layout of 

template file. When a label file is created from the template, new objects cannot be 

added and properties of template objects cannot be changed. This option can be set 

when creating the template in the file options. 

• Excel/Visio 2010 (32-bit): The LabelMark AddIns are now supported in Excel 2010 

and Visio 2010 (32-bit versions only). Note: The LabelMark AddIns do work if you 

run the 32-bit versions of Excel 2010 and Visio 2010 on a 64-bit machine. 

• Printer/Part mapping test print: Users can print a test label when setting up a 

printer/part mapping to make sure that the output is aligned correctly on the part. 

• Test print first row of labels: Before printing a large amount of labels, users can test 

print the first row of labels in the file to the printer to make sure that the output is 

aligned correctly on the part. 

• Split selected linked objects: Users can select linked objects and unlink all of the 

selected objects so they can be moved/edited individually. 

• Favorite parts list: If users have set up a favorite parts list, the favorite parts list is 

shown by default when the parts selector is shown. 

• B498 parts: Added the new B498 parts to the stock parts database. 

• B595 parts: Replaced the B580 parts with the new B595 parts in the stock parts 
database. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

• LabelMark Start page: Added a Start tab that opens when LabelMark starts up. It 

allows the user to quickly create new label or template files based on recently used 

parts, open recently used files, or create label or template files based on the part in 
a hassle free printer. 

Bug Fixes 

• Auto update localization - If LabelMark was installed in a language other than English 

and an auto update is available before the LabelMark settings file is generated then 

the first auto update screen was not in the user's specified language. Once the auto 

update program restarts, everything is displayed in the user's specified language. 

• Advanced data import - Fixed a bug where users were not able to link their data 

import fields to template text boxes. 

• Advanced data import - Fixed a bug where users were not able to link their data 

import fields to text boxes when the number of data import fields was greater than 

the number of text boxes on the label. 

• Opening legacy files - Some legacy files were opening with the label height and width 

swapped. 

• Paste non graphical labels - When working with non graphical labels, LabelMark did 

not allow users to paste whole labels in the same file or to another file. 

• Data Import with wiremark - If side one and side two of a label had wiremark mode 

turned on and then the user did a data import and chose to duplicate side 1 data on 

side 2, wiremark mode was not turned on for the second side of the label after the 

data import. 



• DataMatrix barcodes with data source - If the user performed an advanced data 

import or advanced data serialization and linked the data to a barcode and then 

changed the barcode type to DataMatrix, the barcode would disappear from the 

label. 

• TLS printing: There is an issue printing to TLS printers with the 3.x firmware that 

occurs when there is a big vertical gap between zones (e.g. part PTL-64) where the 

gap is ignored. This bug is fixed in the TLS 2200 print driver (not in LabelMark) so 

you need to download the 3.02 version of the TLS 2200 print driver and update your 
existing print driver to see this fix. 

Known Issues 

• Excel/Visio 2010 (64-bit) - The LabelMark AddIns are not supported for the 64-bit 

versions of Excel 2010 and Visio 2010. Note: The LabelMark AddIns do work if you 

run the 32-bit versions of Excel 2010 and Visio 2010 on a 64-bit machine. 

• BBP72 print preview - When previewing a print job using the BBP72 printer with the 

"Standard" option selected for printing the second side, the print preview is 

incorrect. The print preview shows the output as if the user had chosen the 

"Reverse" option for printing the second side. Note: This issue is only in the print 

preview. The output generated from the printer is correct if you choose to print the 
second side using the "Standard" or "Reverse" option. 

LABELMARK 5.2.6 Release Notes 
Build 5.2.6.2 (Sept 2010) 

Bug Fixes 

• Error trying to open files: LabelMark was failing to open old files because the installer 

did not update a config file when upgrading from a previous release. 

• Add-Ins crash after data import: Fixed a crash that occurred after importing data via 

LabelMark Add-In 

LABELMARK 5.2.5 Release Notes 
Build 5.2.5.2 (Aug 2010) 

Bug Fixes 

• Error opening LabelMark 5.x files: Fixed an error that occurs when opening 
LabelMark 5.x files containing a delimited file data import. 

LABELMARK 5.2.4 Release Notes 
Build 5.2.4.41 (Aug 2010) 

New Features/Enhancements 

Standard Edition 

• Added New Languages: LabelMark has added support for the following languages: 

English, French, Spanish, Portuguese, German, Dutch, and Italian. 



• Default to Favorites part list: When users have set up a favorites part list, the 

favorites tab will be the default tab displayed when New File dialog is displayed. 

• Added European Parts: New parts were added to support LabelMark users in Europe. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

Bug Fixes 

• Office Add-Ins runtime error: The Add-Ins for Microsoft Office did not load in 

LabelMark 5.2.2. The Add-Ins should behave the same as before the previous 

release. 

• Crash importing Htxt files: Fixed a crash that occurred when importing Htxt files into 

LabelMark. 

• Fixed Non-Graphical Data Import Preview: When the font size of a line was changed 

on the label, the change was not being reflected in the Data Import preview. 

• No prompt to save when exiting after editing serialization: After opening a file and 

editing the serialized text, LabelMark was not prompting the user to save their 

changes before closing the file. 

• Cannot print legacy LabelMark file with empty wiremarked label: An error would 

occur trying to print a legacy LabelMark file that contained an empty label that had 

wiremark mode turned on. 

• LabelMark was not sending correct part name to Wraptor: When printing to the 

Wraptor printer, LabelMark was not sending the correct part name to the printer. 

• Linking to template fields in data import: When doing an advanced import on a label 

created from a template, the user was not able to link an imported field to a text box 

from the template. 

• Linking to template fields in data import: When doing an advanced import on a label 

created from a template, the user was not able to link an imported field to a text box 

from the template. 

• Sensor Type for THT-18-430: Fixed the sensor type sent to the printing for part THT-

18-430 when printing to an IP printer. 

• Minimum Font Size in Application Options: Reduced the minimum font size allowed in 

the application options to 4 to match the lowest option when creating a label file. 

• Print offsets has no effect when working in metric: When LabelMark was set to work 

in metric units, the print offsets were not being applied to the print. 

LABELMARK 5.2.2 Release Notes 
Build 5.2.2.11 (June 2010) 

New Features/Enhancements 

Standard Edition 

• Hassle-Free Printing for networked IP printers: LabelMark is able to retrieve and 

display the supply information from IP printers connected via a TCP port (networked 

printer). This gives users the ability to perform hassle-free printing for networked IP 

printers. 

Pro Edition 



• The Pro edition contains all the new features listed for the Standard edition. 

Bug Fixes 

• New BBP11 driver (6/10) sends wrong page size to printer: The new BBP11 driver 

was not sending the correct page size to the printer when printing from previous 

versions of LabelMark causing the print to be shifted and the sending the printer into 

an error state. 

LABELMARK 5.2.1 Release Notes 
Build 5.2.1.3 (June 2010) 

New Features/Enhancements 

Standard Edition 

• New BMP71 Parts: New BMP71 parts were added to the parts database. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

LABELMARK 5.2 Release Notes 
Build 5.2.0.263 (May 2010) 

New Features/Enhancements 

Standard Edition 

• Custom Toolbar: You can customize what commands are shown on the pre-defined 

toolbars. There is a new Custom toolbar that customize and show. This toolbar lets 

you add commands that are not available on the other toolbars as well as a lot of the 

commands from the pre-defined toolbars. 

• New parts: A lot of new part names were added to the parts database, including 

parts starting with the following prefixes: HX, 2HX, ZH, 2ZH. 

• Update files to new part when opening file: When opening files that were created 

with old parts, LabelMark will give the user an option to change the file to the new 

part. 

• Open/Import multiple files: You can now open/import multiple LabelMark 3.x, 4.x, 

and 5.x files at a time by selecting multiple files in the open file dialog. 

• Stretch rotated objects: Added the ability to stretch an object when it is rotated if 

the object allows it (e.g. an image with ‘Allow Stretch’ set to true or a rectangle 
object). 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition 

• Convert Heatex text files: LabelMark can convert Heatex text files, update the 

Heatex part in each file to a corresponding LabelMark part, and create a job file 

containing the new LabelMark files through an easy to use wizard. Note: The 



LabelMark CD contains a Heatex conversion Utility to convert Heatex files to Heatex 
text files that LabelMark can convert into LabelMark files. 

Bug Fixes 

• IP/BP-PR Plus printers back feed during print: When printing smaller labels (e.g. 

THT-29) the IP printer may back feed in between labels during the print job when 

LabelMark and the windows spooler can not send label jobs to the printer as fast as 

the printer is printing them. 

• LM 5.x takes longer to print to the IP and BP-PR Plus printers: It took LM 5 longer to 

spool a print job to the printer when printing a large job with a lot of pages. 

• Wrong IP sensor type for THTEP parts: The following parts had the wrong sensor 

type for IP printers: THTEP-171, THTEP-172, THTEP-173, THTEP-174, THTEP-175, 

THTEP-176, THTEP-177, and THTEP-178. 

• Changed M71EP parts with center cutout: The zones for the following parts were 

changed to have a non printable center circle: M71EP-167, M71EP-168, and M71EP-

169. 

• Hassle-free printing with 3PS parts: LabelMark was incorrectly identifying 3PS parts 

as PS3 parts when displaying the bidirectional information. 

• Windows 7 and Windows Vista auto update notification: Non-admin users running 

Windows 7 and Windows Vista are not receiving auto update notifications. Note: This 

issue is fixed in LabelMark 5.2 but users will not receive any auto update notifications 

until after they update to LabelMark 5.2. 

• Printing job files with copies: When printing job files, LabelMark now defaults to 

printing the File Label Copies instead of defaulting to printing All Labels 

• UPC-A barcodes: When opening a LabelMark 3.x, 4.x or IdentiLab 1.x file, UPC-A 

barcodes were incorrectly compressed in both the horizontal and vertical directions. 

When printing job files, LabelMark now defaults to printing the File Label Copies 

instead of defaulting to printing All Labels 

• Print Preview error: Fixed an error that occurred during print preview when the 

previewing a print job where the first label was blank. 

• Editing non-graphical rotated text: Fixed position of text and text edit box when 

editing rotated text in non graphical mode. Also fixed an issue where the position of 

the cursor was incorrect when opening text that was not left justified. 

• Expand/Condense in label from template: If the user chose a value for 

expand/condense for a text box that came from a template file and the new value 

caused the text not to fit, it did not fail as expected. Now the text is chopped off and 

the text box turns red indicating it is an error state because the text does not fit 

inside the area defined by the template. 

• Sub/Superscript and Autofit: When an autofit text box reduced the font size of the 

text and then the user changed some of the text to be sub/superscript, the font size 

of the sub/superscript text unexpectedly changed back to the original font size. 

• Printing sleeves with BBP11: Improved the placement of the print when printing to 

sleeve materials using the BBP11 printer. 

• IP printing on clean Windows 7: Fixed an issue that can occur when printing to an IP 

printer on Windows 7. The issue only occurred if none of the old Brady 2.x drivers 

were ever installed on the machine because of a registry permissions problem. 

• TPS parts in wizards: Added the TPS parts to the Wire Harness Application Wizard 
and the Wires category in the Control Panel Application Wizard 

Known Issues 



• IP Printer / Permasleeve parts: If you try to print right up to the edge of a 

permasleeve part using the IP printer, you may need to adjust the output slightly 

either through LabelMark or in the printer settings. 

• BBP81 Printer / Permasleeve parts: If you try to print right up to the edge of a 

permasleeve part using the BBP81 printer, you may need to adjust the output 

slightly either through LabelMark or in the printer settings to account for some 

variation in the notch detection. 

• Multiple IP printers attached via USB: A Buffer overflow error is occurring when 

multiple IP printers are hooked up to the same machine via USB. One current 

workaround is to attach one printer as a network printer. 

• TLS printing: There is an issue printing to TLS printers with the 3.x firmware that 

occurs when there is a big vertical gap between zones (e.g. part PTL-64) where the 
gap is ignored. This bug will be addressed in the next driver release. 

LABELMARK 5.1 Release Notes 
Build 5.1.0.253 (Apr 2010) 

New Features/Enhancements 

Standard Edition 

• BMP71 Hassle-free printing: LabelMark communicates with the BMP71 printer to 

detect the tape and ribbon supplies currently installed in the printer so you can easily 

create labels for the supply in the printer. LabelMark can also warn you at print time 

if you do not have the correct supply in the printer for the file you are about to print. 

• BMP71 Parts: The parts database was updated to include new BMP71 parts. Most of 

the new parts start with ‘M71C-‘ or ‘BM71-‘ 

• IdentiLab: You can now open and edit your old IdentiLab 1.x files in LabelMark. You 

can also add subscript/superscript characters to your text 

• IdentiLab Parts: The parts database was updated to include all the parts that were in 

IdentiLab 1.x. 

• BBP11 Printing: LabelMark added support for the BBP11You can now open and edit 

your old IdentiLab 1.x files in LabelMark. 

• Printer Part Pairing UI: Added spin controls to easily adjust the horizontal and 

vertical adjustment values. This also fixed an issue where you had to type a ‘0’ 

before a decimal value if you wanted to type in a value between -1 and 1 otherwise 

the value was detected as invalid. 

• Desktop Icon LabelMark installs a desktop shortcut when the application is installed. 

• Label View Rotation: You can change the angle at which the label(s) are viewed 

similar to LabelMark 4.x. This functionality is allowed in Single Label Layout and 
Multiple Label Layout modes. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

• Laboratory Labels Wizard: Use the Laboratory Labels wizard to create labels specific 
for laboratory applications. 

Bug Fixes 



• IP-Series 3.0.1 Print Drivers: The 3.0.1 print drivers fix a spooler service crash that 

occurred when you tried to get the hassle-free information from the printer when the 

printer was in an error state. It also fixes a USB Buffer overflow error that would 

occur on the printer eventually causing LabelMark to loose bidirectional 

communication with the printer. NOTE: To see these fixes you must install the new 

3.0.1 print drivers. 

• Auto Update Crash: Removed the smart tags from the release notes that were 

invoking Lotus Notes 7.0.2 and causing our auto update process to crash. 

• Text Toolbar: Changed the text toolbar so that it operates the same as the text 

options in the object properties window. 

• Barcode Ratio: Fixed an error in rendering the barcodes for fractional barcode ratio 

values. 

• Changing Label Part: Fixed a display problem that occurred in non graphical mode 

when you changed the label part and the new part had a larger height or width. The 

lines of text would not cover the whole label unless you scrolled down and selected a 

new label and then scrolled back up. Now when you change the label part, the lines 

of text are extended to cover the whole label. 

• Saving Labels Error: When trying to save non graphical labels that contained data 

bound object(s), an error would occur if you had edited the data bound object(s) 

multiple times. This error did not occur in graphical labels. 

• UPC Barcode Text Location: Fixed a problem where the text location for UPC-A and 

UPC-E barcodes would change from Top Middle to HR Top Middle or Bottom Middle to 

HR Bottom Middle when you selected the barcode. 

• Undo Crash: Fixed a crash that occurred when you deleted a line in non graphical 

mode using the Backspace key and then tried to undo your change. 

• Command Multiplier Crash: Fixed a crash that occurred when tried to command 

multiply an object in non graphical label that was not in the first zone of a multi zone 

label. 

• Paste label: When trying to paste a non graphical label, the text on the first line was 

not showing up on the label. 

• Template Objects Removed: When opening a non graphical label file created from a 

template, some of the template objects were removed from labels that only 

contained template objects. 

• Min RAM Requirement During Install: Some machines with 512MB RAM were not 

allowed to install LabelMark because the MSI installer detected less than 512MB 

RAM. 

• Centered Template Objects: When creating a label from a non graphical template, 

text objects that had been centered in the template were not being rendered in the 

center of the label. 

• Update Part Definition: Changed the sensor type for THT-80 from Gapped to 

Notched. 

• BP-1244/BP-1344: Changed the print logic for these printers to fix an issue where 

only the first label was being printed repeatedly. 

• Property Window Behavior: Changed the behavior in the object property window 

when the OS regional options specify a comma as the decimal symbol to work the 
same as when a period is specified as the decimal symbol. 

Known Issues 

• IP Printer back feeds during print: When printing smaller labels (e.g. THT-29) the IP 

printer may back feed in between labels during the print job when LabelMark and the 

windows spooler can not send label jobs to the printer as fast as the printer is 
printing them. 



LABELMARK 5.0.2 Release Notes 
Build 5.0.2.1 (Jan 2010) 

Bug Fixes 

• Opening LabelMark 3.x and 4.x files: An error would occur when trying to open any 

LabelMark 3.x or 4.x label file or template file 

LABELMARK 5.0.1 Release Notes 
Build 5.0.1.17 (Jan 2010) 

New Features/Enhancements 

Standard Edition 

• Online Software Updates: LabelMark will check for updates when the application 

starts and will notify you when an update is available. You can turn off this 

functionality in the application options but then you are responsible for manually 

checking for updates to the software. 

• Create Label Based on Template LabelMark will lock the text box size of all selectable 

text boxes. When you click on a selectable text box or navigate to one using the 

keyboard it will open for editing right away to allow easier data entry. 

• Zoom ‘Fit To Page’: You can now tell LabelMark to zoom so that at least one whole 

row of labels will be visible. This is the default zoom when you create a new file or 

open an exiting file. 

• Fill Screen With Labels: When you zoom out LabelMark will add empty labels to fill 

the screen. If no printable objects are added to these extra labels they will not be 

printed. 

• New parts: THT-213 and X-128-482 were added to the master parts list. 

• New parts: Brady B-345 High Temperature PermaSleeve™ Wire Markers are 

specifically designed for high temperature and low outgassing wire and cable 

identification applications. B-345 is available in 2” width, double-sided format. Heat-

shrink ratio is 2:1, except the 3/32" diameter, which is 3:1. The new parts are 

available in the master parts list and start with one of the following prefixes: ‘2HT-’, 
‘3HT-’, or ‘PSHT-’. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition. 

Bug Fixes 

• Memory leak: When selecting labels and text objects in a non-graphical label, 

LabelMark was consuming more memory than it needed to. 

• Hassle-free printing: Sometimes an error would occur when trying to find bi-

directional printers with hassle free printing capabilities on machines with certain 

print drivers installed. 

• Setting Security on Settings file: When LabelMark was installed on non English 

operating systems or English Vista Home, LabelMark failed to startup because of an 

error that occurred when trying to set the ACL list on the settings file. 



• Keyboard Navigation: On some larger parts like THTEP-178 users could not navigate 

to the second label using the keyboard. 

• Keyboard Navigation: When the first line of a non graphical template had the ‘Can 

Select’ property set to false, there were ways to select and edit that line using 

keyboard navigation. 

• Ruler Track Lines: The track lines on the ruler were not correct when rotated objects 

were selected. 

• >LabelMark 4.x and 3.x files: Some legacy LabelMark files did not open properly if 

they had wiremarked non-printable zones in them. 

• Printing Multiple Copies of A Range: Each label was being printed ‘x’ number of times 

before the next label in the range. 

• Barcode ‘Value’ property: The ‘Value’ property for barcodes bound to a data source 

was wrong when you clicked on different barcodes. 

• VC++ Runtime Installer: The installer incorrectly identified the VC++ runtime as 

missing on Windows Vista and Windows 7 operating systems after it had been 

installed. 

• Custom Parts Designer: The part family selection was incorrect in the custom parts 

designer when you went back into the custom parts designer and viewed a 

previously created part. 
• THT-37 Sensor Type: Changed the THT-37 sensor type to gap. 

Known Issues 

• .NET runtime on Vista x64: The Microsoft .NET 3.5 installer does not cancel 

immediately after the user clicks the Cancel button. If the user does press the cancel 

button then subsequent attempts to run the Microsoft .NET 3.5 installer may fail. 

LABELMARK 5.0 Release Notes 
Build 5.0.0.2670 (Nov 2009) 

New Features/Enhancements 

• N/A. 

Bug Fixes 

• Hassle-free printing: An error would occur on machines with a GlobalMark print 

driver installed when the user was trying to create a label or template file based on 

the supply in the IP printer. 

• Bi-Directional Printer Information: An error would occur on Windows 7 when 
LabelMark would try to get the bi-directional printer information from an IP printer. 

LABELMARK 5.0 Release Notes 
Build 5.0.0.2666 (Oct 2009) 

New Features/Enhancements 

Standard Edition 

• Online Software Updates: Ability to download software updates directly from the 

Brady website. Once you purchase an upgrade license, you will receive the activation 



code and the password to do online activation. Using this information, you can 

upgrade from Standard to Professional edition via online or telephone activation 

methods. If the software versions are same, you do not have to reinstall the 

software. 

• Manage Custom Parts: Lets you create user-defined label parts. These parts can be 

based on factory created stock parts or completely original, defined by the user. 

These custom parts can be exported to be shared with other users. 

• Create New, Based on Selected Labels: You can now create new label sets based on 

pre-designed label parts. 

• Error Checking Utility: When designing labels, LabelMark automatically checks for 

formatting errors, allowing you to edit the information before printing the labels. The 

formatting errors are displayed in the Errors and Information window, which is 

always on display at the bottom of the workspace. Allows automatic fitting of data 

through Autofit. 

• Edit/Use a Template File: You can create new label files based on pre-formatted label 

templates. Items placed on a label in the template will be repeated on all labels in 

the template and can be locked into place so that they cannot be removed or edited 

when using the template to create a label file. 

Pro Edition 

• The Pro edition contains all the new features listed for the Standard edition, plus the 

following: 

• Part Printer Driver Association: You can now pair a printer and label part to indicate 

to the application that whenever you print using the specified part, by default it will 

print to the specified printer. You can then also set the corrective offsets if needed 

for that printer. 

• Manage/Use Serialization Schemes: A serialization scheme is a set of multiple 

counters (components) and serialization types, combined and prioritized to 

determine how each component affects the others to advance the sequencing. You 

can now save complex serialization schemes to use at a later date so you do not 

have to re-enter the data the next time you want to use this serialization. 

• Manage/Use Import Data Schemes: A data scheme (or workflow map) is a 

configuration of files, fields and records from an external data source to be placed on 

labels. You can now save complex import data schemes to use at a later date so you 

do not have to re-enter the data the next time you want to use this imported data. 

• Insert/Edit an AutoCAD Object: You can place full or partial AutoCAD drawings, or 

just the text from a drawing, on labels in LabelMark by either exporting directly from 

AutoCAD or importing from LabelMark. 

• Data Extraction Add-ins (MS Excel, MS Visio, AutoCAD): You can create labels using 

full or partial Microsoft Visio drawings, or just the text from the drawing, by 

exporting directly from MS Visio. You can also extract fields (columns) of data from 

MS Excel directly from inside the MS Excel program or by importing external data 

from inside the LabelMark program. 

• Copies Function: The Label Copies toggle button indicates the number of copies of a 

single label to print. A Label Copies toggle button displays next to each label. You 

can set different number of copies for each label. The summation of copies for each 

individual label displays in the Total labels: field in the Print dialog box. 

• Wire Harness Sub-Wizard: Use the Wire Harness wizard to create labels specific for 

wire harness applications. 

• Control Panel Sub-Wizard: Use the Control Panel wizard to create labels used on 

various types of control panels, including wire, face plate, push button, and terminal 

block. 



• Label Object Property Window: When a label element is selected, the Properties box 

displays. Use the Properties box to make desired changes to the element. The 

options available in the Properties box varies according to the element selected. 

Bug Fixes 

• N/A 

Known Issues 

• AutoCAD on Vista in User Mode: AutoCAD versions 2000 to 2007 run on Vista in 

Admin Mode only with LabelMark. When in User Mode a) early versions of AutoCAD 

do not load the LabelMark toolbar because of the AutoCAD “automation error”. b) 

Some versions of AutoCAD show error message (about memory usage exceptions) 

just after AutoCAD closes completely. AutoCAD versions from 2008 till 2010 run 

without any problem. 

• Cannot Print to IP Series Printer (300 or 600) when on a File Port : Cannot Print to 

File when an IP Series printer is configured to a file port. Error message is displayed 

informing that printer isn’t connected. 

• Cannot Print or Use IP Series Printer (300 or 600) when connected using Ethernet: 

IP series printers will only work with this version of LabelMark 5 when connected 

using USB or Serial connection methods. TCP/IP connection is not currently 

supported. 

• LabelMark does not save the print mode (Tear Off, Peel Off, None) when saving LM 

files with the Brady IP Printers. 

• THTEL-184-483 Some stock is printed upside-down and shifted on the pre-printed 

content zone. 

• Saving to the system drive: When a user is logged in as a user and not as an Admin, 

they may receive an exception on invoking ‘Tools> ‘Manage Custom Parts’ if the 

system drive (e.g. C:\) is defined to store custom parts via ‘Tools>Options>File 

Paths>Custom Parts File Location when a user is logged in as a user and not as an 

Admin, they may receive an exception on invoking ‘Tools> Manage Custom Parts’ if 

the system drive (e.g. C:\) is defined to store custom parts via ‘Tools>Options>File 

Paths>Custom Parts File Location’. This is due to the user not having access to the 

file/folder in question. 

• Horizontal/Vertical Print Adjustment can cause print out to be cut off: The user 

defined print adjustment (via ‘File>Print’ and ‘Tools>Manage Printer/Part Pairing’ 

dialog) can cut off the output along the ‘Print Preview’ borders and on the printed 

supply. When specifying adjustments, the label size is not increased since this can 
cause certain printers to error out. 
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